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ImageNow 5.4 Viewer Quick Start Guide 
This document contains information on how to view and search for linked documents within ImageNow. The various viewer toolbars available to 
you within ImageNow are also explained. 

 

Log in and start the ImageNow client 
ImageNow can be started in several ways. You can start ImageNow by double-clicking the ImageNow icon on the desktop, or by clicking Start, 
pointing to Programs, and then clicking ImageNow; you can also start ImageNow by clicking the Tray icon . 

As you start ImageNow, you will see the following splash screen: 

  
Important   If the Profile list box is blank, then a Login Profile has not been configured. Please contact your system administrator to configure the 
following profile fields: Server ID, Protocol, Port Number, and User ID. 

1. In the Profile list box, select the profile you want to use. 

2. In the User ID box, confirm or enter the user name. 

3. In the Password box, enter your password. 

4. Click Connect to initiate the connection to the ImageNow Server. The ImageNow ControlBar will display if you are successfully logged 
into ImageNow: 

 
Note   If you are unable to connect to the server, verify that you entered the user ID and password correctly. 
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ControlBar toolbar 
The ControlBar toolbar contains several icons that enable you to perform many essential ImageNow Actions. The icons correspond to the options 
in the Actions menu. 

 
The following options are available: 

Icon Option  Description 
 View Performs Enabled View based on selected applet. 
 Capture  Initiates capture process. 

 Batch Opens Batch View grid. 

 Search  Opens Document Search grid. 

 Workflow Opens Workflow grid. 

Note   Some of the options may appear grayed out. If an option is grayed out, you do not have access to that option. Workflow options may appear 
grayed out if workflow has not been configured on the system or you do not have workflow permissions assigned. 

 

 

 Applet menu 

When using Enabled View within ImageNow, you must be aware of the currently selected applet. The Applet menu on the ControlBar shows the 
currently selected applet. 

An applet is a container that holds all of the information that ImageNow needs to communicate with and gather data from your host application. In 
most cases, a single applet is used to communicate with the host application. If you have integrated ImageNow with more than one host 
application, you may see multiple applets in the Applet menu. 

 

View a document 
ImageNow enables you to quickly search for and view linked documents. Every object or image that is stored within ImageNow is linked with 
individual data index keys, or DocKeys. These DocKeys make document retrieval fast, efficient, and accurate. You can view a document using the 
View icon located on the ImageNow ControlBar. 

Using the View Icon  
The View icon initiates a search of records that have already been view-enabled (linked) by your host system. The search takes information from 
the open host application and cross-references it with records linked and stored within ImageNow. The Document Search grid will display any 
documents found that match the DocKeys defined in the host application. 
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Follow these steps to search for a document with the View icon: 

Important   ImageNow can only view records in your application that have been previously linked, or predefined, during set-up. In addition, your 
host application must have been previously 'learned' for ImageNow to gather data from it. 

1. While logged into ImageNow, open your host application. 

Note   The host application must be open for the View icon  to search correctly (unless manual entry is used in the applet). 

2. Open a record within the host application that has been View Enabled. 

3. Select the appropriate applet from the ControlBar Applet menu. 

Note   The applet selected will determine which defined DocKeys are searched within the host application. 

4. Click the View icon  on the ControlBar. ImageNow gathers data from the host application record and passes it to the ImageNow 
Server. The server then looks for matches in the gathered data. If a single match is found, a copy of the document is opened and 
displayed in PowerView View Mode (skip step 6, you are finished).  

5. If multiple matching documents are found (i.e., different document types for the same record), the matches will be displayed in a list in 
the Document Search grid. Double-click the selected (highlighted) document that you want to view. A copy of the document is opened 
and displayed inside PowerView View Mode.  

Note   You do not need to save the document; when you are finished viewing it, simply close PowerView (the document will not be deleted or 
misplaced). 
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Search grid 

The Search grid is accessed by clicking the Search Grid icon  from the ControlBar. 

The Search grid enables you to quickly search for and locate stored documents. Each object or image that is stored in ImageNow has individual 
data index keys, or DocKeys. These DocKeys make document retrieval fast, efficient, and accurate. 

 
The Search grid shows documents with their DocKeys and additional index fields. Some of the fields are indexed and some are non-indexed. 
Indexed fields display in the Search grid with bold column headers. Indexed fields can be searched and sorted; non-indexed fields cannot. 

Indexed Fields Non-Indexed Fields 
Drawer 
Folder* 
Tab* 
Field 3* 
Field 4* 
Field 5* 
Scan Date – Creation date and time 
Modification Date 
* Label may display differently in Search grid 

Document Status 
Pages 
Doc ID 0 & Doc ID 1 
Scan User 
Modification User 
Last View User & Date 
Keywords 
Workflow Queue & State & User 
Workflow Item ID 

Once you have located a document in the Search grid, you can view it by double-clicking it; the document will open in PowerView Search Mode.  

 

Search grid toolbar 
The Search grid toolbar enables you to find, annotate, and manage documents. 

 
The following options are available: 

Icon Option Description 
 File Open Opens the selected document. 

 Print Opens the Print dialog box. This enables you to print a screen capture of the Search 
grid dialog box. 

 Export  Opens the Export dialog box. This enables you to export the selected document to a 
remote location. 
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 Delete Deletes the selected document. 

 Notes  Opens the Document Keywords window. This enables you to enter notes about the 
selected document. 

 Properties  Opens a detailed listing of information about the selected document. 

 Find  Opens the Quick Search dialog box. This enables you to quickly search individual 
columns. 

(C-Tree Simple Search only) 
 Table Control  Opens the Table Control dialog box. This enables you to customize the Search grid. 

 Refresh Re-displays document list including additions, changes, or deletions made since the 
last time the Search grid was opened.  

 Toggle Lock Toggles locking of Search grid data for local sorts and searches. 

 Page Down Loads the next set of documents to the on-screen view. 

 Page Up Loads the next set of documents to the on-screen view. 

  

Open a document 
1. In the grid, select (highlight) the document you want to open. 

2. Open the document by doing one of the following: 

• Double-click on the document. 

• Press Enter. 

• From the ControlBar menu bar, select File, Open. 

• From the Grid toolbar, select the Open icon . 

3. The selected document will display in ImageNow PowerView.  

 

PowerView 
When you open a document in ImageNow, the document is launched in PowerView, ImageNow's tool for viewing images. PowerView is the 
primary user interface within ImageNow; it is where most of the document processing will take place. PowerView has several toolbars, modes, and 
components that display during the various stages of document processing. 
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How does PowerView work? 
As each document image is scanned or imported, it is uploaded to the ImageNow Server. You can then use the ImageNow ControlBar to locate 
and retrieve documents for processing. Once a document is requested from the ImageNow ControlBar, the document is downloaded via the 
network and displayed within ImageNow PowerView. 
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PowerView View Mode 
Click the View icon  to display a document in PowerView View Mode. In addition to viewing documents in View Mode, you can also annotate 
documents. 

 

View Mode components 
There are no special properties or toolbars that display inside View Mode. By default, the following toolbars are displayed: 

• File toolbar  

• View toolbar  

• Annotation toolbar  

• Page toolbar  

• Scan toolbar 

The following PowerView components can also be used: 

• Pager Window  

• DocKeys Window  

• Keywords Window  

Opening PowerView View Mode   
Important   ImageNow can only view data from records in your application that have been previously linked, or pre-defined, during set-up. Contact 
your system administrator for clarification on which application records are available for viewing. 

1. While logged into ImageNow, open your host application. 

2. Open a record within the host application that has been View Enabled. 
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3. Select the appropriate applet from the ControlBar Applet menu. 

4. Click the View icon  on the ControlBar. ImageNow gathers data from the host application record and passes it to the ImageNow 
Server. The ImageNow Server then looks for matches in the gathered data. If a match is found, a copy of the document is opened and 
displayed in PowerView View Mode.  

5. If multiple matching documents are found (different document types for the same record), the matches will be displayed in a list in the 
Document Search grid. Double-click the selected (highlighted) document that you want to view. The document will open and display 
inside PowerView View Mode.  

 

File toolbar 
The PowerView File toolbar contains icons that enable you to perform several application-level controls. These icons coincide with several of the 
options contained in the PowerView File menu. 

 
The following options are available: 

Icon Option Description 

 Print Prints the selected document. 

 Email Attaches copy of the selected document in an email message 
(requires appropriate email configuration). 

 Image Info Opens properties dialog box on the selected document. 

 Save As Exports the selected document to be saved under a different 
name. 

 Launch Associated 
Application 

Launches associated application of selected document, such 
as Word, Excel, and Access (if the programs are installed).  

 

 

View toolbar 
The PowerView View toolbar contains several icons that enable you to alter the way the document is displayed in PowerView. The icons coincide 
with several of the options contained in the View menu. 

 
The following options are available: 

Icon Option Description 

 Zoom In Increases the magnification of the selected page by 2x. 

 Zoom Out Decreases the magnification of the selected page by 1/2x. 

 Rotate Left Rotates the selected page counterclockwise 90°.  

 Rotate Right Rotates the selected page clockwise 90°. 

 Fit Window Resizes the selected page to fit in the window. 

 Fit Width Resizes the selected page to fit the entire width in the window. 

 Fit Height  Resizes the selected page to fit the entire height in the window. 

 
Zoom Regions  Selects zoom regions, or saves new zoom regions. 
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Annotation toolbar 
The PowerView Annotation toolbar contains several tools that enable you to annotate document images. 

  
Note   Presently, only TIFF (.tif), Bitmap (.bmp), and JPEG (.jpg) document images support annotations. 

The following options are available: 

Icon Option Description 
 Stamp  Stamps various messages (Approved, Confidential, etc.) on the 

document image. Can be used to create customized stamps. 
 Sticky Note  Places a "note" (text box) on the document image to which 

comments can be added. 
 Text  Enters text on the document image. 

 Highlight  Highlights selected areas of the document image. 
 Check Places a checkmark on the document image. 
 Redline  Draws a line on the document image. 

 Arrow  Draws an arrow on the document image. 

 Solid Mask  Blocks out selected areas of the document image. 
 Hollow Mask  Highlights selected areas of the document image with a rectangular 

outline. 
 Hollow Circle Mask  Highlights selected areas of the document image with a circular 

outline. 
 OLE Item  Embeds sounds, pictures, or any other object supported by your 

system into the document image.   

 Toggle Show 
Annotations  

Shows or hides annotations made on the document image. 

 Move/Resize  Moves or resizes annotations placed on the document image. 

 Annotation Off  De-selects the currently selected annotation. 

 

Page toolbar 
The PowerView Page toolbar enables you to navigate through pages and documents. 

 
The following options are available: 

Icon Option Description 
 Previous Document Opens previous document. 
 First Page Opens first page of document. 
 Previous Page Opens previous page of document. 
 GoTo Page Opens a specified page. 
 Next Page Opens next page of document. 
 Last Page Opens last page of document. 
 Next Document Opens next document. 

 

 

Pager window 
The PowerView Pager enables you to organize the various pages of a multi-page document. To access the Pager, from the PowerView menu bar, 
click View, and then click Pager. By default, the Pager will display under the document window. 



Getting to know ImageNow PowerView Quick Start Guide 

10 

 

Each page icon  represents each page of the document. Each page icon contains a menu that has several options available for the individual 
page. Right-click the page icon of the individual page you want to modify. The following menu will display: 

 
The following options are available:  

Option Description 
Cut Cuts selected page. 
Copy Copies selected page. 
Copy to New Doc… Copies selected page to a new document. 
Move to New Doc… Moves selected page to a new document. 
E-mail Attaches copy of selected page as an e-mail attachment. 
Delete Deletes or removes selected page. 

 

DocKeys window 
The PowerView DocKeys Window contains information used to index and retrieve captured objects. To access the DocKeys Window, select View, 
Document Keys from the PowerView menu bar, or press F7. By default, the DocKeys Window will display to the right of the document window. 

As data is gathered into ImageNow, it is stored in one or more of the Document Keys, or 
DocKeys. The DocKeys are ImageNow’s index fields. The data in these fields is used by 
ImageNow to index and retrieve captured objects. 

There are as many as six DocKeys available within ImageNow. The first field, Drawer, is 
used to separate large groups of captured objects. Security can be applied to a drawer to 
allow access only to certain users. 

In addition to the Drawer field, there are five DocKey fields available to store information 
on captured objects. The DocKey fields are customizable to fit any business model. The 
most important part of a DocKeys structure is that each individual object is uniquely 
defined.  
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Keywords window 
The PowerView Keywords window contains information used to index and retrieve captured objects. To access the Keywords window, select View,  
Keywords from the PowerView menu bar, or press F8. By default, the Keywords window will display to the right of the document window. 

The Keywords window can be used to enter and view notes or other relevant information 
about the object. 

You can also automatically add the time and date you reviewed the object to the Keywords 

window. To add a date stamp, click the Date Stamp icon  in the top left corner of the 
Keywords window.  

 

Once notes are entered, the information can be viewed in the Search grid. The Keywords column displays the information entered into the 
Keywords window.  

 

PowerView title bar 
The PowerView title bar is located along the top of the PowerView window. It contains standard Microsoft® Windows® features that control how it 
appears on the screen. 

 
The PowerView  title bar contains standard Microsoft Windows controls for minimizing, maximizing, restoring, and closing PowerView.  

Button Option Description 
 Minimize Minimizes the PowerView window. 

 Maximize Maximizes the PowerView window. 

 Restore Restores the PowerView window to its original size. 

 Close Closes the PowerView window. 

  

PowerView status bar 
The PowerView status bar is located at the bottom of the PowerView window. The PowerView status bar contains information about the status of 
documents being viewed and processed in PowerView. In Workflow, the status bar can also be used to alert users when an item has been sitting in 
a workflow queue for too long. 
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As shown above, there are four sections within the PowerView status bar. The following table describes each section: 

Section Description 
Icon Description or XY 
Coordinates 

Displays toolbar icon descriptions when the cursor rolls over an icon. If XY Coordinate 
positioning is enabled (View > Show XY Coords), the XY coordinates of the cursor position 
on the document image will display. 

DocKey Values Displays the DocKeys of the displayed image.  
Document Image 
Information 

Information will vary depending on which grid you are using: 
In Workflow Mode: Displays the current workflow queue. 
In Batch Mode: Displays the Batch ID number. 
In Search Mode: Displays Workflow icon  if document has been sent to Workflow. 

Page Indicator Displays the page number of the displayed image and the total number of pages in the 
document. 

Showing x-coordinates and y-coordinates 
1. Open a document image in PowerView. 

2. In the PowerView menu bar, select View, Show XY Coords.  

3. Roll the cursor over the image. The XY Coordinates will display in the bottom left corner of the PowerView status bar. 

Note   To hide the XY Coordinates, select View and uncheck Show XY Coords. 
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Automatically tile open documents 
Automatic Tile enables you to simultaneously view all the pages of a multiple-page document in the PowerView window. By default, PowerView 
automatically tiles the pages in the document as they are opened, allowing you to see all of the opened pages side by side. Each page is opened 
within its own sub-window that can be resized, minimized, maximized, or repositioned. 

 

Disabling Automatic Tile 
In the PowerView View menu, a checkmark appears next to Automatic Tile when the feature is enabled. To disable Automatic Tile, click the 
checkmark to clear it. 
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Additionally, with multiple sub-windows opened, you can use the Window menu to control how the pages of the document are displayed. 

 

The following options are available: 

Option Description 
Cascade Cascades open pages in the PowerView window (Shift+F5). 
Tile Vertically Vertically tiles open pages in the PowerView window (Shift+F4). 
Tile Horizontally Horizontally tiles open pages in the PowerView window. 
Open All From Server Opens all pages of the document in PowerView. 
Close All Closes all open pages of the document (does not close PowerView). 

 

Opening all pages from the server 
ImageNow PowerView allows you to view several different documents at once. Each document opened is placed in a separate PowerView window. 
To retrieve and automatically tile all of the pages in a document, click View, and then click Open All From Server. All of the pages in the selected 
document will display in separate PowerView windows. 

Note   ImageNow is capable of supporting up to 99 simultaneous PowerView windows. 

 

View document properties 
This option is only available in ImageNow 5.4. 

In Search grid, right-click on a document, and then click Properties, or in PowerView, click File, and then click Page Properties to view details 
including DOC ID, Created and Modified information, Index Keys, File type and other properties. 
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